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1.0 EXECUTIVE SUMMARY 

Advanced Geological Servicef?, Inc. (AGS) performed a non-intrusive geophysical 
investigation at Los Alamos National Laboratory (LANL), Technical Area (TA) 54, 
Material Disposal Area (MDA) L on February 6th and 9th, 2004. The objective of the 
survey is to determine the location of former pits, impoundments, and shafts. To 
achieve this objective, an integrated geophysical investigation was proposed using 
terrain conductivity (EM31), high-sensitivity metal detector (EM61), and digital ground­
penetrating radar (GPR) methods. Due to the presence of excessive cultural 
interference (power lines, metal objects and structures, etc.) however, the EM31 method 
could not be used. 

EM61 data were acquired at less than 1 foot intervals along lines spaced from 1 foot to 
10 feet apart. A total of 11,148 measurements were acquired along a total survey line 
length of 5,487 feet. The data set ranges from -10.94 to 4,030.04 milliVolts (mV) with a 
standard deviation and arithmetic mean of 318.16 and 116.10 mV, respectively. 

GPR data were acquired over disposal unit locations to refine interpreted lateral 
boundaries and attempt to determine the vertical extent. Data were acquired 
continuously along a total line length of 2,430 ft. A recording window of 60 
nanoseconds (ns) was used, which provided a depth of exploration of approximately 8 
ft. A 400 MHz transducer, which provided excellent lateral and vertical resolution, was 
chosen to perform the survey. 

In spite of the cultural interfere and obstructions encountered at the site, the 
geophysical investigation successfully determined the lateral location of the majority of 
disposal units at MDA L. These geophysical results correlate well with the locations 
that are based on historical information. Only minor deviations between data sources 
were observed with the greatest deviations occurring at shaft locations in the southeast 
(Shafts 1 through 5) and northwest (Shafts 29 through 34) portions of the site. 

The lateral extent of the pits interpreted from the GPR data generally corroborate the 
locations indicated in historical data. The vertical extent of the pits and shafts could not 
be confidently determined by GPR methods due to insufficient penetration or 
insufficient contrasts in physical properties. 
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2.0 INTRODUCTION 

Advanced Geological Services, Inc. (AGS) performed a non-intrusive geophysical 
investigation at Los Alamos National Laboratory (LANL) Technical Area (T A) 54, 
Material Disposal Area (MDA) L on February 6 and 9, 2004. The objective of the survey 
is to determine the location of former pits, impoundments, and shafts. To achieve this 
objective, an integrated geophysical investigation was proposed using terrain 
conductivity (EM31), high-sensitivity metal detector (EM61), and digital ground­
penetrating radar (GPR) methods. Due to the presence of excessive cultural 
interference (power lines, metal objects and structures, etc.) however, the EM31 method 
could not be used. 

EM61 data were acquired to locate buried metal objects within the target areas to help 
define the lateral location of former shafts and pits. EM61 data could not be acquired at 
a1llocations because of excessive cultural interference and obstructions. The GPR data 
were acquired over existing pits, impoundments, and shafts to further refine 
boundaries and locations interpreted from the EM61 data. Since the GPR method is less 
sensitive to cultural interference, it could be used inside the structures where the EM61 
could not. The integrated use of these techniques produced a complementary effect, 
which resulted in higher confidence levels and more complete subsurface information. 
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3.0 BACKGROUND 

MDA L encompasses approximately 2.5 acres and contains one inactive subsurface 
disposal pit (Pit A), three inactive subsurface treatment and disposal impoundments 
(Pits B, C, and D), and 34 inactive disposal shafts (Shafts 1 through 34). The pit, 
impoundments, and shafts are constructed in the Tshirege Member of the Bandelier 
Tuff, a consolidated tuff unit. The topography of MDA L is relatively flat. The majority 
of the surface of MDA L is paved with asphalt. 

Historically, MD A L was used for treating and disposing of non-radiological liquid 
chemical wastes (i.e. acids, caustics, cyanide solutions, chromium waste, and solvents). 
Disposal of these types of wastes no longer occurs at this site. LANL drawings AB113 
(LANL 1993, 76052) and ENG-C-45259 (DOE 1987, 25606) have been used to identify the 
locations of the pit, impoundments, and shafts at MDA L. There are no visible surface 
expressions of the pit or the impoundments because asphalt covers most of the surface 
of MDA L. Most of the shaft locations (but not all) are marked with brass caps pressed 
into the asphalt indicating the approximate location of each shaft. Figure 1 shows the 
locations of the pit, impoundments, and shafts as well as other site surface features. 

4 




4.0 METHODOLOGY 

4.1. GEODETIC POSITIONING 

The geophysical instruments were integrated with a differential global positioning 
(DGPS) system to allow real-time navigation, to provide accurate location of 
geophysical measurements, to eliminate the need to establish a local reference grid, and 
to allow direct integration with LANL's geographic information system (GIS). The 
geographic positions of all measurement points were acquired at I-second intervals as 
the geophysical data were collected. The data were acquired using a Trimble 
Pathfinder Pro XRS system, which allowed accurate positioning with real-time accuracy 
better than 1 meter. All geographic data presented in the report are presented using the 
U.s. State Plane 1983 coordinate system, New Mexico Central 3002 zone, NAD 1983 
datum. 

4.2. HIGH-SENSITIVITY METAL DETECTOR (EM61) 

Buried metal objects can be effectively located using a Geonics EM61-MK2 High­
Sensitivity Metal Detector. The EM61 is a time domain electromagnetic (EM) system 
that can discriminate between conductive soils and metal objects. It has numerous 
advantages over other commonly used metal detection devices. For example, it is 
significantly less sensitive to cultural interference such as aboveground metal objects 
and overhead power lines. 

The EM61 generates rapid electromagnetic pulses and measures the response of the 
subsurface between pulses. Secondary EM fields are generated in the ground after each 
pulse. These fields dissipate rapidly in earth materials but remain for a longer time in 
buried metal objects. The EM61 measures the prolonged metal response only after the 
earth response has dissipated. This response is measured and displayed in millivolts 
(mV). 

The EM61 uses a portable time-domain transmitter and two receiver coils. The data 
received from the second receiver coil can be used to reduce the unwanted effects from 
interference and near-surface objects that can mask deeper and more significant objects. 

Very high-resolution data are automatically recorded as the sensors are pulled along 
the ground surface. Survey wheels attached to the sensors facilitate data collection by 
allowing direct measurement of the distance traveled. The lateral position of each 
measurement is automatically recorded using a data logger. This method allows data 
to be recorded virtually as fast as the operator can walk. 

For this investigation, data were collected at less than 2-ft intervals along lines spaced 
approximately 5-ft apart. Line separation sometimes varied depending upon surface 
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obstructions such as dense vegetation. Geodetic coordinates were recorded at l-second 
intervals using an integrated GPS system so that each measurement point could be 
accurately located. A base station, which was free from cultural interference, was 
occupied at the beginning and end of each survey day to calibrate the instrument and 
perform system functional tests. During these tests, battery, data repeatability, and 
sensitivity checks were performed. 

4.3. GROUND PENETRA TING RADAR (GPR) 

The GPR technique uses the transmission and reflection of radio waves to image objects 
beneath the ground surface. The technique responds to changes in the electrical 
properties of the earth or buried materials. A GPR target must possess electrical 
characteristics that are different from the surrounding media in order to be detected. 
When the transmitted wave encounters an anomalous object or layer, the wave is 
reflected back to the surface where it is recorded and analyzed. The waves are 
transmitted rapidly such that a continuous subsurface image is generated as the 
transmitter is pulled along the ground surface. 

The GPR survey was performed using a digital SIR-2 Subsurface Interface Radar 
System, manufactured by Geophysical Survey Systems, Inc. Following initial field tests 
to determine maximum penetration and sufficient resolution, a 400 MHz transducer 
was chosen to perform the survey. Data were digitally recorded, displayed, and 
analyzed during acquisition to allow real-time interpretation. Line locations were 
chosen based on EM anomaly location and surface obstructions. 
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5.0 RESULTS AND DISCUSSION 

5.1. HIGH SENSITIVITY METAL DETECTOR (EM61) DATA 

EM61 data were acquired at less than 1 foot intervals along lines spaced from 1 foot to 
10 feet apart. A total of 11,148 measurements were acquired along a total survey line 
length of 5,487 feet. The data set ranges from -10.94 to 4,030.04 milliVolts (mV) with a 
standard deviation and arithmetic mean of 318.16 and 116.10 mV, respectively. A color­
enhanced plan map of the EM61 data acquired at MDA L presented Figure 2.1 Since the 
instrument is designed to respond only to metal objects, all anomalies observed on the 
map are attributed to both buried metal objects and metal structures at or above the 
ground surface. 

The EM61 survey areas were chosen to provide coverage of the existing disposal units. 
However, the presence of cultural interference and obstructions prevented data 
acquisition in some areas. Data could not be acquired inside the existing structure that 
covers most of Pits A, B, and C and in the storage structure located at the southeast 
corner of the site. Both of these structures contained metal containers and other metal 
objects that created excessive interference. 

EM61 data were acquired in the northwestern portion of the site to locate Shafts 29 to 
34. Shafts 35 and 36 were not survey because they are located within a restricted area 
and their location can be visually observed. The elevated EM61 values observed 
around the perimeter of the northwestern area are attributed interference from the 
chain-link fences and other metal structures at the ground surface. The large anomaly 
near grid node 1759600N/1639725E is caused by metal posts that surround an existing 
monitoring well. The locations of three low amplitude anomalies are coincident with 
the historical locations of Shafts 29 through 31. The shape and amplitude of the 
anomalies as well as their location with respect to the historical information suggest 
that they are associated with the buried shafts. A fourth anomaly is located south of 
Shaft 31 however; the historical data does not indicate the presence of a shaft at this 
location. No EM61 anomalies were observed at the suspected locations of Shafts 33 and 
34. GPR data were acquired over this area to further investigate the presence of these 
shafts. These results are presented in Section 5.2. 

1 All EM61 data and maps are provided on the enclosed CD. Oasis montajTM Interface software is also 
provided to facilitate data evaluation and to output maps and databases. An introduction to using the 
software is provided in Appendix A. 
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Similar EM61 responses were observed over Shafts 18, 19, 23, 26, 27, and 28. These 
anomalies are also attributed to the former shafts. They are not caused by the brass 
caps that mark the approximate location of the shafts. The data presented in the map 
are filtered to suppress the effects of small, near surface metal objects. For example, a 
brass does not exist for Shaft 23 yet the anomaly shown in the figure is significant. The 
remaining shaft locations could not be surveyed using the EM61 but they were further 
investigated using CPR. 

Data were acquired in the open areas near Pits B, C, and D. The majority of Pits A, B, 
and C are located inside an existing structure and could not be surveyed with the EM61. 
The majority data that were acquired outside the structures were influenced by cultural 
interference from the structure itself. The southern half of Pit D shows no significant 
anomalies, which suggests the absence of buried metal objects in this location. Linear 
anomalies are observed southwest of Pit D. Their configuration and amplitude 
suggests they are caused by buried utilities. 

5.2. GROUND PENETRATING RADAR (GPR) DATA 

CPR data were acquired over disposal unit locations to refine interpreted lateral 
boundaries and attempt to determine the vertical extent2. Data were acquired 
continuously along a total line length of 2,430 ft. A recording window of 60 
nanoseconds (ns) was used, which provided a depth of exploration of approximately 8 
ft. Scans were acquired at 32 scans/ sec with 512 samples per scan. A 400 MHz 
transducer was chosen to perform the survey, which provided excellent lateral and 
vertical resolution. 

The locations of the CPR profile lines are shown in Figure 3. The CPS system was used 
to map the line locations for all profiles acquired outside existing structures. A local 
grid system was established for profiles located inside existing structures since CPS 
satellite reception was not possible. 

Orthogonal CPR transects were acquired over the shafts located in the southeastern 
portion of the survey area. These data were interpreted as they were collected on the 
instrument's color display. The interpreted locations of the shafts were spray painted 
on the ground immediately following interpretation. Figure 3 shows the interpreted 
locations of the shafts based on the CPR data. In general, there is an excellent 
correlation between interpreted locations and those based on historical data. However, 
poor correlation exists between Shafts 1 through 5 and the CPR data. Only four 
anomalies were attributed to disposal shafts in this area. 

2 GPR data are provided on the CD enclosed with this report. REFLEX Data Viewer™ software is 
included, which will allow detailed data eva1uation as well as printing and other output capabilities. An 
introduction to using the software is provided in Appendix B. 
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The vertical extent of the shafts could not be determined using GPR because of 
insufficient signal penetration. The maximum depth of investigation observed during 
this survey was approximately 10 ft. The depth of penetration in the shaft locations was 
less. Since the GPR signal does not penetrate metal, metallic objects contained within 
the shafts would reduce or eliminate signal penetration or produce a scattering effect. 
The caps of disposal shafts were observed at many locations and were interpreted at 
depths ranging from 1 to 4 feet. 

Figure 4 presents example GPR profiles acquired over selected shaft locations. The four 
examples at the top of the figure correspond to shafts located in the southeastern 
portion of the site. The profile at the bottom of the figure corresponds to data acquired 
in the northwestern portion of the site. There was no physical evidence of the shaft 
locations in the northwestern portion because either the brass markers were missing or 
they were beneath snow at the time of the survey. For this reason, closely spaced radar 
profiles were run to provide near complete coverage. A profile of Line 93 is shown in 
the bottom of Figure 4. In general, good correlation exits between the location of GPR 
anomalies and historical shaft locations. However, a smaller yet similar anomaly occurs 
at approximately 22 feet on the profile line that does not correspond to any known 
disposal shaft. GPR anomalies that appear to be associated with disposal shafts are 
identified in Figure 3. 

Figure 5 presents GPR profiles acquired over Pit D. The boundaries of this pit are 
clearly observed in most profiles that cross over it. Strong signal diffractions are 
observed along most of the pit boundaries. This signature type usually occurs at near~ 
vertical interfaces between contrasting materials. Chaotic reflection events, commonly 
associated with disturbed subsurface conditions, are also observed within the 
interpreted pit location. The interpreted base of the asphalt cover is also shown in these 
profiles. The interpreted thickness of asphalt material ranges from approximately 0.5 to 
2 ft in the surveyed areas. The thickness appears to be greater in the northeast portions 
of the site. 

Figure 6 shows profiles acquired across the short axes of Pits B, C, and D. Again, signal 
diffractions that delineate the lateral extent of the pit are observed at locations 
coincident with historical information. Figure 7 presents an example GPR profile 
acquired over Pit A. The profile shows relatively flat reflectors that are associated with 
subsurface layering. The boundary of Pit A was not observed in all profiles. Figure 8 
shows the interpreted pit boundaries and shaft locations based on the geophysical data. 

The vertical extent of the pits could not be confidently interpreted because of either 
insufficient penetration or insufficient contrasts in electrical properties between the pit 
materials and tuff bedrock. 

9 




6.0 CONCLUSIONS 

In spite of the cultural interfere and obstructions encountered at the site, the 
geophysical investigation successfully determined the lateral location of the majority of 
disposal units at MDA L. These geophysical results correlate well with the locations 
that are based on historical information. Only minor deviations in the shaft locations 
were observed as shown in Figure 3. The greatest deviations occur at shaft locations in 
the southeast (Shafts 1 through 5) and northwest (Shafts 29 through 34) portions of the 
site where ambiguous GPR results were encountered. 

The lateral extent of the pits interpreted from the GPR data generally corroborates the 
disposal unit location indicated in historical records. Not all lateral pit boundaries were 
observed but those that were are shown in Figure 8. The vertical extent of the pits and 
shafts could not be confidently determined by GPR methods due to insufficient 
penetration or insufficient contrasts in physical properties. 
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SHAFTJD X_gp_survey Y_gp_survey X_JCU13 Y_JCI_113 

-

1 na na 1640157,29 1759397.40 
2 1640154,99 1759387,15 1640153,05 1759389.56 
3 1640152,25 1759379.74 1640149.91 1759382.37 
4 1640149,72 1759374.77 1640146.57 1759375.68 
5 1640147.18 1759370.18 1640142.86 1759367.30 
6 1640134,21 1759357,31 1640134.19 1759357.40 
7 1640119.58 1759360.43 1640119.50 1759360,33 
8 1640112.17 1759364.33 1640112.19 1759364.31 
9 1640105.24 1759367,55 1640105.02 1759367.62 
10 1640097,73 1759371,35 1640097.64 1759371.36 
11 1640086,13 1759380.32 1640086.15 1759380.35 
12 1640067,40 1759388.57 1640067.46 1759388.73 
13 1640053.16 1759392.27 1640053.84 1759391.81 
14 1640046.33 1759395.59 1640046.87 1759395.64 
15 1640040.68 1759397.54 1640040.02 1759398.67 
16 1640032.29 1759402,42 1640032.18 1759402.67 
17 na na 1640025.19 1759406.04 
18 1640015.12 1759411,58 1640012.28 1759411,99 
19 1639995.42 1759420,56 1639995.21 1759420.90 

not part of survey not part of survey 1640119.55 1759369.00 
not part of survey not part of survey 1640112.03 1759373.11 
not part of survey not part of survey 1640105.12 1759377.00 

23 na na 1639975.77 1759430.55 
26a 1639960.90 1759438,11 1639960.84 1759438.02 
27 1639949.58 1759443,96 1639949.15 1759443.90 
25 1640063.30 1759406.12 1640063.47 1759406,13 

26b 1640044,97 1759414,90 1640045.30 1759414.96 
28 1639939.05 1759449,04 1639939.20 1759448.85 
33 1639689.80 1759618.33 1639691.55 1759615.19 
29 1639709,58 1759621.77 1639707.79 1759623.55 
30 na na 1639723.34 1759615.97 
31 1639748.47 1759615.22 1639740.01 1759609.47 
32 1639743.91 1759594.78 1639757.60 1759601,20 
34 na na 1639706.66 1759604,46 

not part of survey not part of survey 1639621.38 1759573,39 
not part of survey not part of survey 1639631.28 1759583,85 

match 
'", 

no match 
not part of survey 

http:1639631.28
http:1639621.38
http:1639706.66
http:1639757.60
http:1759594.78
http:1639743.91
http:1759609.47
http:1639740.01
http:1759615.22
http:1639748.47
http:1759615.97
http:1639723.34
http:1759623.55
http:1639707.79
http:1759621.77
http:1759615.19
http:1639691.55
http:1759618.33
http:1639689.80
http:1759448.85
http:1639939.20
http:1639939.05
http:1759414.96
http:1640045.30
http:1640063.47
http:1759406.12
http:1640063.30
http:1759443.90
http:1639949.15
http:1639949.58
http:1759438.02
http:1639960.84
http:1639960.90
http:1759430.55
http:1639975.77
http:1759377.00
http:1640105.12
http:1759373.11
http:1640112.03
http:1759369.00
http:1640119.55
http:1759420.90
http:1639995.21
http:1639995.42
http:1640012.28
http:1640015.12
http:1759406.04
http:1640025.19
http:1759402.67
http:1640032.18
http:1640032.29
http:1759398.67
http:1640040.02
http:1759397.54
http:1640040.68
http:1759395.64
http:1640046.87
http:1759395.59
http:1640046.33
http:1759391.81
http:1640053.84
http:1759392.27
http:1640053.16
http:1759388.73
http:1640067.46
http:1759388.57
http:1759380.35
http:1640086.15
http:1759380.32
http:1759371.36
http:1640097.64
http:1759367.62
http:1640105.02
http:1640105.24
http:1759364.31
http:1640112.19
http:1759364.33
http:1640112.17
http:1640119.50
http:1759360.43
http:1640119.58
http:1759357.40
http:1640134.19
http:1759367.30
http:1640142.86
http:1759370.18
http:1640147.18
http:1759375.68
http:1640146.57
http:1759374.77
http:1759382.37
http:1640149.91
http:1759379.74
http:1759389.56
http:1759397.40


X_Discrepancy Y_Discrepancy Notes 

na na no anomoly found 

2 2 anomoly found. minor spatial discrepancy 


na na no anomoly found 


na na na 

na na na 

na na na 

na na no anomoly found 


na na no anomoly found 


na na no anomoly found 

na na na 

na na na 


2 3 anomoly found. minor spatial discrepancy 

3 1 anomoly found. minor spatial discrepancy 

4 3 anomoly found. minor spatial discrepancy 

0 0 anomoly matches Jel As-Buitt AB 113 

0 0 anomoly matches Jet As-Built AB 113 

0 0 anomoly matches Jet As-Built AB 113 

0 0 anomoly matches Jel As-Built AB 113 

0 0 anomoly matches Jel As-Built AB 113 

0 0 anomoly matches Jel As-Built AS 113 

0 0 anomoly matches Jet As-Built AB 113 

1 0 anomoly matches Jel As-Built AB 113 

1 0 anomoly matches Jel As-Built AB 113 

1 1 anomoly matches Jet As-Built AS 113 

0 0 anomoly matches JC I As-Built AS 113 


3 0 anomoly found. minor spatial discrepancy 

0 0 anomoly matches Jel As-Built AB 113 


0 0 anomoly matches JCt As-Built AB 113 

0 0 anomoly matches JCI As-Built AB 113 

0 0 anomoly matches JCt As-Built AB 113 

0 0 anomoly matches Jel As-Built AB 113 

0 0 anomoly matches JCt As-Built AS 113 

2 3 anomoly found. minor spatial discrepancy 

2 2 anomoly found. minor spatial discrepancy 


8 6 anomoly found, major spatial discrepancy 

14 6 anomoly found, major spatial discrepancy 
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GUIDE TO USING THE OASIS MONTAJ FREE INTERFACE 


The following provides a brief overview of the steps necessary to the Oasis montaj Free 
Interface software to review, print, and export the EM31 data provided on the enclosed 
CD. More detailed help is provided in the online help system and PDF file included 
with the software. 

1. Create a Workspace 

);> On the File menu, click New Workspace. The program displays the New 
Workspace dialog box. 

);> Specify a name and directory for the workspace. For example, name the 
workspace data and specify the working directory as C:\tutorial\data. OASIS 
montaj will automatically look for your data in the directory containing this 
workspace. 

» Click [Save]. The system saves the workspace with the corresponding name. 

2. Open a Database File 

» On the Data menu, click Open then click, Database. 

» In the File name box, specify the name of database you want to open. 

» Click [OK] the database is displayed in the spreadsheet window. 

3. Open Corresponding Map File 

» On the Map menu, click Open map. The Open Map dialog box is displayed. 

~ Select the map file (*.map) that corresponds to the database file selected above 
and click [Open]. 

» To open multiple maps hold down the [Shift] key and select the maps to open. 

4. Inspect the Data Using Database Dynamic Linking 

Dynamic links are interactive graphical connections that you can activate between 
databases, profiles and any number of maps in your workspace. When you activate 
links and select any item or position in a database, profile or map, a cursor 
automatically connects the item or point in all views. This means that you if you select 
a cell in a database, Oasis montaj will identify that same data point in all open maps and 
profiles that are displayed. 
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Database linking is designed for visualizing data for an entire database - the system 
automatically scrolls through the database to show the corresponding data each time 
you select a line on a map. 

» To create a dynamic link, click the Shadow Cursor with Data Link ( ..•. ) button. 
Then position the Shadow Cursor with Data Link cursor on a survey line in the 
map. The system automatically displays the corresponding data and profile for 
the line you selected. 

The advantage of database linking is that you can quickly navigate through your 
database, using all three views (spreadsheet, profile, and map) to select data for further 
processing or to analyze and interpret the dataset. 

5. 	Print a Map 

» Select (highlight) the map that you would like to print. 

» On the File menu, click Print. The system displays the Print dialog box. 

» Specify the Region you want to print (current Viewed Area or the Entire Map). 

;.. Specify the Plot Scale. To maintain the map scale, select the Use ~ale Factor 
option and specify a value, (1 =100 per cent). If you use this option, the map 
may require more than one page depending on the media to which you are 
printing or plotting. 

;.. 	 If the plot is being paneled, specify either the All Panels option or the Range of 
panels option to print. If you are printing multiple panels, you can specify an 
overlap in mm. This helps you to match panels later. 

» Specify the number of copies to be printed. 


;.. If required, select the Print to File option box and specify a filename. 


» Select the Centre on Page option box to centre the plot on the page. To centre the 

plot on a paper roll select the Fit On Roll option box. 

» To move the map from its origin (lower left comer of page or plot), specify an 
offset distance in mm. 

;.. Click the [print] button to send the map or plot to the currently configured 
printer or plotter. 

5. 	 Exporting a Map to a File 

» Select an open map in your workspace. 
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)- Select the Map IExport ... menu option. The system displays the Export Map 
tool. 

)- Select the region you want to export (viewed - i.e. current portion displayed in 
Map window, full or selection - specify area in centimeters or pixels). 

)- Select the export format and the resolution if required. 

)- Click [OK]. The system requests a filename. 

)- Specify the filename and click [OK]. The system exports the map. 
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QUICK START GUIDE TO USING THE REFLEX DATAVIEW SOFTWARE 

The following is a brief overview of using the REFLEX Data View software. More 
detailed help is provided in the online help system file included with the software. 
REFLEX DataView is a free Windows95/NT 32 bit program for displaying georadar or 
seismic data. The data must exist in the REFLEX~format. 

The capabilities of REFLEX DataView: 

? display of the data either in wiggle or filled area point mode 

? the user may switch between two different scale modes: (1) the data are 
completely plotted into the actual window with subsequent free zooming and 
moving possibilities (2) trace based scale: the user chooses the pixel size for each 
trace. If the line is not completely plotted into the window moving possibilities 
are available. 

? zoom- and autoscroll possibilities 

? many different plot options, e.g. rotated display, combination of wiggle and 
point mode, free selectable axis and so on 

? interactive color amplitude assignment for point mode 

? interactive magnifying glass option with selectable zoom factor 

? a freely selectable data part is continuously magnified when moving the mouse 

? easy transfer of the data to the clipboard 

? printing out the data with freely selectable scale 

1. Open Data File 

? On the File menu, click Load. The program displays the Load dialog 
box. 

? Specify a name and directory for the file you wish to view. 

? Click [OK]. The file is displayed in the viewing window. 

2. Inspect the Profile Data File 

? 	 The button bar along the top of the window provides several tools that 
allow the user to zoom in and magnify portions of the profile. 
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> 	The color schemes of the display can be changed to suit the user's 
preferences. On the Plot menu, click Plot Options. The Plot Options 
dialog box is displayed. Change the color scheme by selecting the 
desired color palette under the Point Mode Attributes section. 

3. Load Layershow 

> The Load Layershow option allows inspection of interpreted 
boundaries of the former Lagoon Area. 


> On the File menu, click Load LayerShow. 


> Select the desired file and click OK. 


> The interpreted interface is displayed. 


4. Print a Profile 

> On the File menu, click Print. The program displays the Print dialog 
box. 

> Select the appropriate scales, page orientation, and other attributes 
according to user's preferences. 

> Select the desired printer by clicking on the Printer Setup button. 

> Click the Print button 
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